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Session Organization 

This session was designed to be instructor-led and follows traditional classroom activities you may have been 
previously exposed to. In this course, the instructor will present information about how to use Banner and – at 
times – ask that you complete activities and exercises in this manual. You will find that following along in the 
manual will help you to successfully complete this course. 
 

  Please avoid trying to follow the instructor using your computer until asked to do so.   

Session Manual Key 

Discussion:  Look, listen, interact, and learn!  These 
pages will focus on concepts, highlight certain 
topics/items, or even ask for your feedback. 
Procedure:  Look, listen.  That’s basically it…watch 
the demonstration and follow along in your manual. 

On Your Own Activity:  The instructor talked about it, 
you’ve seen it…now perform the task following the 
steps provided. 
Exercise:  Test your knowledge and skills!  Complete 
the exercise per the instructions.  If you need 
help…just ask!  We want you to succeed. 

 

 
 

 
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Banner Navigation - Session Agenda 

Lesson 1: Introduction to Banner  
 Topic 1:  The Function of Banner 
 Topic 2:  Systems Interfacing with Banner 
 Topic 3:  Major Features of Banner 
Lesson 2: Getting Started in Banner 

 Topic 1:  Log On to Banner 
 Topic 2:  Parts of the Interface 
 Topic 3:  Forms 
 Topic 4:  Keyboard Shortcuts 

Lesson 3: Banner Forms 
 Topic 1:  Types of Banner Forms 

 Topic 2:  Understanding Form Names  
 Topic 3:  Accessing Forms  
 
   Lesson 4: Performing Inquiries  
 Topic 1:  Querying and Using Wildcards 
            Topic 2:  Performing a Query Using a Form Field  
            Topic 3:  Performing a Query Using an Application Form 
            Topic 4:  Performing a Query Using an Inquiry Form 
            Topic 5:  Commonly Used Forms to Query 

 
 

Lesson 5:  Defining and Understanding FOAPAL 
 Topic 1: Define and Identify FOAPAL String and Elements 
 Topic 2: Identify Index Codes 
  
Lesson 6: Features In Banner 

Topic 1:  Using the Calculator 
Topic 2:  Using the Calendar 
 Topic 3:  Changing the Banner Password 
 

Appendix : Session Key Points 
Topic 1:  Toolbar Buttons 
Topic 2:  Keyboard Shortcuts 
Topic 3:  Form Names 
Topic 4:  Common Inquiry Forms 

 

 

Session Agenda 
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Navigation - Session Overview 

In Banner Navigation, you will learn how to: 

•  Log on to Banner 
•  Navigate within Banner 
•  Locate and Access Forms 
•  Execute basic Banner inquiries 
•  Understand FOAPAL  

Upon completion of this class you will be an important part of the University-wide Banner 
network. 

 

 

Session Overview 

(Return to Table of Contents) 
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Lesson 1: Introduction to Banner - Overview 

Introduction Overview 

Assuming the Banner Information System is new to you, it is critical that you understand its 
role and function at WSU, the information systems that interface with it, and its major 
features. 

By the end of this short discussion you will have identified the following: 

1. The functions and major features of Banner. 
2. The tools for navigating within Banner. 

 

 
 

Lesson 1: Introduction to Banner 
  Overview   

(Return to Table of Contents) 
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Topic 1: The Function of Banner 

Banner is a suite of products. These products access a common database so that 
information can be shared across different systems that administer the numerous 
functions of the University.  Some of the systems that Banner supports within the 
University are Student, HRMS, Alumni and FMS.   

As a processor of information at WSU, you are certain to have diverse needs that vary 
widely in your unit.  You may use Banner to access one system or many systems.   

 

Lesson 1: Introduction to Banner 
Topic 1: The Function of Banner 

(Return to Table of Contents) 
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Topic 2:  Systems Interfacing With Banner 

Banner is a University-wide 
system which enables you to 
track, maintain and report your 
department’s important 
information. 

Let’s begin by taking an overall 
look at Banner and its 
connection to other operations 
here at WSU, as shown with the 
graphic on the right. 

Banner 

Student 
System 

Financial  
Management System 

FMS 

Purchasing 
Payables System 

(PPS) 

Human  
Resource System 

(HRMS) 

Alumni 
Development 

System 

Cashiering 
System 

 

Lesson 1: Introduction to Banner 
Topic 2: Systems Interfacing with Banner 

(Return to Table of Contents) 
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Topic 3:  Major Features of Banner 

Banner includes the following major features: 
 Internet-Based — Banner 7.x provides many functions which are internet-based.  A 

primary benefit is improved access to the tools you need. 
 User-Friendly Design—Banner looks and operates like many of the typical 

“windows” applications you’re already using!  Menus and the mouse are available to 
users.  

Major Features of Banner 
Banner is an online product which utilizes the Oracle Relational Database Management System. 
At Wayne State University, Banner is integrated with systems such as Student, Alumni/ 
Development, Financial Management,  and Human Resources. This capability enables you to 
access information that already exists in any of these systems. 

 

Lesson 1: Introduction to Banner 
Topic 3:  Major Features of Banner 

(Return to Table of Contents) 
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Lesson 2: Getting Started in Banner - Overview & Agenda 

Lesson Agenda 

Topic 1: Log On To Banner 
Topic 2: Parts of the Interface 
Topic 3: Forms 
Topic 4:  Using the Mouse and Keyboard 

 

Lesson Overview 
The Banner interface is designed as a Graphical User Interface (GUI).  A GUI uses 
pictures to represent features and functions of Banner, allowing simple control of the 
program.  

This lesson will introduce you to the basic layout of Banner and the names and functions 
of key elements of the program interface.  

Before you can navigate within Banner, you will need to differentiate between “areas” of 
the software.  Doing so will help you in the lessons that follow – and ultimately ensure 
your success in using Banner effectively. 

Lesson 2: Getting Started in Banner 
Overview & Agenda 

(Return to Table of Contents) 
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Topic 1: Log On To Banner 

To begin working in Banner, you must log on to the system. 
 
To do this back at your desk, you will need three things: 

 1.  WSU Access ID  
 2.  * Banner access account and a Banner “profile” which gets you “in the door”  
        to do what you need to do for your job. 
 3.  Compatible browsers: 
      ** Internet Explorer 
      ** Firefox 
* Banner security access forms are located at this website : 

 http://computing.wayne.edu 
** Latest system requirements are listed at:  
  http://computing.wayne.edu/hardware 

 

Lesson 2: Getting Started in Banner 
Topic 1: Log On To Banner 

(Return to Table of Contents) 
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Procedure: Log On To Banner   

Lesson 2: Getting Started in Banner 
Topic 1: Log On To Banner 

Procedure: 
 

1) Launch your internet 
browser. 

2) Log on to WSU Pipeline. 
3) Click the Employee tab. 
4) Click the Banner link   

located on the left side  
portion of the screen. 

5) Enter your user name. 
6) Enter your password. 
7) Click the Connect button. 

Banner will open 

Alternate access to Banner: 
a) Launch your internet 

browser. 
b) Enter banner.wayne.edu in  

the address field - click ‘go’. 
c) Follow steps 5-7 above. 

1 

3 

4 

5 

6 

7 

b 

(Return to Table of Contents) 
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Topic 2: Parts of the Interface 

This lesson will introduce you to the basic parts of the Banner interface and the names and 
functions of key elements found on forms: 

What you will learn in this topic: 

• Menu bar 
• Toolbar 
• Auto hint 
• Status line 
 
Items needed to complete this topic: 

• Access to the Banner icon 
• User name 
• User password 
 

 

Lesson 2: Getting Started in Banner  
Topic 2: Parts of the Interface 

(Return to Table of Contents) 
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Menu Bar 
The Banner menu bar, located at the 
top of every form, contains pull-down 
menus.  

Note:  If a menu item is dimmed, it is 
disabled and cannot be accessed. 

Toolbars 

The toolbar holds a set of buttons that 
offer quick access to commonly used 
Banner functions.  

Discussion: Menu Bar & Toolbar  

Lesson 2: Getting Started in Banner 
Topic 2: Parts of the Interface 

Menu Bar 

Toolbar 

     
    

Tool Tips provide the name of the 
button the mouse cursor points at. 

View/Send 
Message 

Next 
Block Save Select 

Remove 
Record 

Previous 
Record 

Previous 
Block 

Rollback Insert 
Record 

Enter 
Query 

Cancel 
Query 

Next 
Record Exit 

Print  
 

Help 

SCT Banner 
XtenderSolutions 

Execute 
Query 

(Return to Table of Contents) 
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Discussion: Auto Hint Line  

Auto Hint Line 
The auto hint line, at the bottom of 
a form window, contains information 
about the field where the cursor is 
located: 
•   Gives KEY information about 
 what you should do 

•   Error and processing 
 messages  

•   Keyboard equivalents, if you can 
 access other blocks, windows, or 
 forms from the field 

Lesson 2: Getting Started in Banner 
Topic 2: Parts of the Interface 

NOTE: Look at your auto hint line 
frequently. This is the only place  
where Banner tells you what it can 
and can not do! 
 

Auto Hint—field 
description 

(Return to Table of Contents) 
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Discussion: Sample Auto Hint Messages and Status Line  

Lesson 2: Getting Started in Banner 
Topic 2: Parts of the Interface 

Sample Auto Hint Messages 
• Query caused no records to be found. Re-enter.  
• Mandatory required field. 
• Invalid function; press SHOW KEYS for valid functions. 
• Enter a name Last, First, Middle and press enter or tab. Use the 

wildcard % if needed. 
• Enter NEXT or leave BLANK for automatic assignment or enter 

document number. 
• Enter document type or choose LIST to view valid options. 

• Request is approved – no changes are allowed.  
• Press Enter to start selection or expand/collapse menu. 

Status Line 
The status line, beneath the auto hint line, may contain the following 
messages: 
• Record n/n 
• Enter query 

(Return to Table of Contents) 
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On Your Own Activity: Parts of the Interface  

Identify these parts of the 
interface by filling in the 
blanks using the 
following terms below: 

• Status Line 

• Menu Bar 

• Auto Hint 

• Toolbar 

 

Lesson 2: Getting Started in Banner 
Topic 2: Parts of the Interface 

1. 

2. 

4. 

3. 

(Return to Table of Contents) 
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Topic 3: Forms 

What you will learn in this topic: 

• Key blocks and data blocks 
• Fields 
• Working with tabs 
• The Options menu 

 
     

 

 

Lesson 2: Getting Started in Banner 
Topic 3: Forms 

A form is an online document where you can enter and look up information in Banner.  A 
form visually organizes information so it is easier to enter and read.  

A form is made up of fields. Data is entered into fields within Banner   A form also has 
common parts such as a title, window(s), key blocks and data blocks.   

 A form in Banner is similar to a paper document except information is only entered once and 
can then be used by other Banner forms.  The more you know and understand the parts of 
the form, the easier it will be for you to work in Banner. 

 

(Return to Table of Contents) 
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Discussion:  Layout of a Banner Form 

Data is entered into Banner on 
forms. 

Think of these forms as paper 
documents because they have 
many of the same features.  On a 
paper document, like an Employee 
Information form, you have a: 
•  Title (name of the document) 
•  Windows (Sections & Blocks) 
•  Key Blocks (specific document #) 
•  Fields 

Similarly, Banner  forms have many 
of the same design elements:  
•  Titles 
•  Windows 
•  Key Blocks 
•  Data Blocks 
•  Fields 

 

Lesson 2: Getting Started in Banner 
Topic 3: Forms 

Key block 
Title bar 

Data blocks Data blocks 

(Return to Table of Contents) 
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Discussion: Key Blocks 

When the cursor is in the key block, enterable fields in the key block are enabled. 
These same fields are disabled when the cursor leaves the key block. 

The first block on most forms 
contains key information. This key 
block generally identifies the record, 
which determines what is entered or 
displayed on the rest of the form.  
All information on the form refers to 
the Key block.  

The Key block has at least one 
field and many times more.  For 
example, a form that maintains 
financial information may have Key 
block fields for both a chart of 
accounts and a fiscal year. 

The Key block typically stays on the 
form as subsequent blocks appear.  

 

Lesson 2: Getting Started in Banner 
Topic 3: Forms 

Key block 

(Return to Table of Contents) 
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Discussion: Data Blocks 

A Data block is a section of a form 
or window that contains 
information related to the record 
identified in the key block.  

If a form or window contains more 
than one block, each block will 
have a yellow border at the top. 

 

Lesson 2: Getting Started in Banner 
Topic 3: Forms 

Data blocks 

Note:  To move from the Key block 
to the Data blocks, do a 
Next Block.  This action 
populates the data fields 
with information that exists. 

(Return to Table of Contents) 
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Discussion: Options Menu  

Lesson 2: Getting Started in Banner  
Topic 3: Forms 

The OPTIONS menu contains links 
that take you to other blocks and 
windows within the current form.   

Additional links take you outside the 
current form to other related forms.  

The available options change as 
the cursor location changes within a 
form.  

(Return to Table of Contents) 



 Page: 22 

Version 1.2 
June, 2007 

Discussion: Using Tabs 

Some forms provide navigation tabs 
that allow you to move from one 
section of a form to another: 

• Some navigation tabs allow you 
to move to different data blocks 
of the current form at random. 

• Some forms do not allow you to 
advance to another tab until you 
have completed all required fields 
in the current data block.  

 

Lesson 2: Getting Started in Banner 
Topic 3: Forms 

Tabs 

(Return to Table of Contents) 
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Discussion: Fields 
Fields are areas on a form where 
you can enter, query, change, and 
display specific information. The 
following terms describe the status 
of a field: 

 Enabled & Enterable: You 
can put the cursor in the 
field and enter information. 

 Disabled & Display only: 
You cannot put the cursor 
in the field and you cannot 
enter information. Typically, 
disabled fields are 
automatically populated by 
entries in other fields. This 
ensures the accuracy of 
information by preventing  
spelling and data entry 
errors. 

 

Lesson 2: Getting Started in Banner 
Topic 3: Forms 

Enabled Fields 

Disabled Fields 

(Return to Table of Contents) 



 Page: 24 

Version 1.2 
June, 2007 

On Your Own Activity: Parts of a Form 

Identify these form parts by writing 
the correct name in the blank 
boxes next to the item using the 
terms in the column below. 

A. Fields 
B. Options Menu 
C. Data Block 
D. Key Block 
E. Title Bar 
F. Navigation Tabs 

Terms: 

1. 

 

Lesson 2: Getting Started in Banner  
Lesson Activity – Parts of a Form 

4. 

3. 

2. 

5. 

6. 

(Return to Table of Contents) 



 Page: 25 

Version 1.2 
June, 2007 

Topic 4: Using the Mouse and Keyboard 

Like other software applications, you may use many keyboard and mouse shortcuts to 
navigate within Banner. 

What you will learn in this topic: 

How to navigate through Banner using keyboard and mouse shortcuts. 

 

Lesson 2: Getting Started in Banner 
Topic 4: Using the Mouse & Keyboard 

(Return to Table of Contents) 
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Discussion: Keyboard Shortcut List  

You can use keyboard shortcuts to 
quickly perform certain Banner functions 

Here’s a list of most of the keyboard 
shortcuts available here at WSU. 

Lesson 2: Getting Started in Banner 
Topic 4: Using the Mouse & Keyboard 

Keys Description 

Ctrl F1 Display “Show Keys” window 

F2 | shift + F2    --  | count query hits 

F3 | shift + F3    -- | SELECT record 

F4 | shift + F4 Record duplicate | 

F5 | shift + F5    --  | Clear block 

F6 | shift + F6 Insert record  | Delete record 

*F7 | shift + F7 Enter query | Rollback 

*F8 | shift + F8 Execute query   | print 

F9 List – Search 

F10 Save changes 

*Ctrl + pg  Next block 

*Ctrl + pg  Previous block 

Ctrl + u Clear item field 

*Tab Next item field 

Shift Tab  Previous item field (reverse direction) 

*Ctrl + q Acts as ‘exit’ button – cancels a query or exits 
current form 

NOTE #1: Standard Windows shortcuts for copy (ctrl+c), 
cut (ctrl+x) and paste (ctrl+v) function within Banner.  

*Fundamental keystrokes for all users (Return to Table of Contents) 
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Discussion: Mouse Shortcut  

A useful mouse shortcut involves right-
clicking on the screen inside a Banner 
form.  

By doing so, a pop-up window appears  
providing all items from the options menu 
as well as a number of additional Banner 
functions such as rollback, save, exit, and 
print. 

Lesson 2: Getting Started in Banner 
Topic 4: Using the Mouse & Keyboard 

(Return to Table of Contents) 
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Review: Getting Started in Banner 

In this lesson you: 

• Learned how to log on to Banner. (Topic 1) 

• Identified the parts of the Banner screen. (Topic 2) 

• Learned common parts of a form and the typical form layout. (Topic 3) 

• Learned how to use the mouse and keyboard to get around. (Topic 4) 

 

Lesson 2: Getting Started in Banner 
Lesson Review 

Key concepts: 

• The keyboard—Banner is inconsistent with the mouse, so we introduced you to 
keyboard shortcuts. 

• Auto-hint line—This is where Banner talks to us. 

• Options menu —Illustrates the logical flow of the business process. 

(Return to Table of Contents) 
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Lesson 3: Banner Forms - Overview & Agenda 

Lesson Overview 

Like other software applications, there are multiple methods and procedures for navigating 
within Banner to complete a task.  

Banner provides you with several ways to find and work with various forms.  As you become 
familiar with Banner, you will be able to move about easily through the screens.  

Lesson Agenda 

Topic 1:  Form Names - what they can tell you about a form’s function 
Topic 2:  How to access Banner forms using  

– Go to… field 
– Direct Access 
– Main Menu 
– My Banner 
– Last 10 Forms listed in the File menu 

 

Lesson 3: Banner Forms 
Lesson Overview & Agenda 

(Return to Table of Contents) 
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Topic 1: Understanding Form Names  

Each form in Banner has a 7 character name – this name is an acronym which tells you 
about the type of information the form contains, the University business process it is related 
to, and much, much more. 

What you will learn in this topic: 
How to interpret the 7-character name of a form. 
 

Lesson 3: Banner Forms 
Topic 1: Understanding Form Names 

(Return to Table of Contents) 
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Discussion: Understanding Form Names – Continued  

Position 1: 
Identifies the primary system 
owning the form. 

 
Position 2: 

Identifies the business process 
(module) owning the form. 

 
Position 3: 

Identifies the form type. 
 
Positions 4-7: 

Uniquely identifies the form. 

1 
• Accounting (T) 
• HR/Payroll / 
Personnel (P) 

• Position Control 
(N) 

• Student (S) 
• Financial (F) 

2 

• General Person (P) 
• Application (A) 
• Budget (B) 
• COBRA (C) 
• Benefit/Deductions (D) 
• Employee (E) 
• Electronic Approvals (R) 
• “Overall” to a business 

process (O) 
• General to a business 

process (G) 
• Purchasing (P) 

3 
• Application (A) 
• Inquiry (I) 
• Validation (V) 
• Maintenance (M) 

4-7 
Examples: 
• Identification (IDEN) 
• Position (POSN) 
• Encumbrance (ENCB) 
• Employee (EMPL) 
• Job information 
 (JOBS) 
• Requisition (REQN) 
• Check (CHEK). 

P P A IDEN 

Lesson 3: Banner Forms 
Topic 1: Understanding Form Names 

 

(Return to Table of Contents) 
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Position 1: 
Identifies the primary system 
owning the form 

 
Position 2: 

Identifies the business process  
(module) owning the form 

 
Position 3: 

Identifies the type of form 
 
Position 4-7: 

Uniquely identifies the form 

Example: FPAREQN 
 
 
F = Finance 
 
  
P = Purchasing 
 
 
A = Application 
 
 
REQN = Requisition 

Discussion: Example Form Names 

Example: SAAADMS 
 
 
S = Student 
 
 
A = Admissions 
 
 
A = Application 
 
 
ADMS = Admissions 

Example: POIIDEN 
 
 
P = HR/Payroll/Personnel 
 
 
O = Overall to a business     
       process 
 
 
I = Inquiry 
 
 
IDEN = Employee Search 
Form (Employee, Applicant, 
COBRA) 

Some examples… 

Lesson 3: Banner Forms 
Topic 1: Understanding Form Names 

 

(Return to Table of Contents) 
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On Your Own Activity: Understanding Form Names 

For the Banner form FGIENCB, fill in the blanks below, identifying the elements of the form name: 

1) The primary system owning the form 
2) The business process owning the form 
3) The type of form 
4) The unique identification of the form 

F = 

G = 

I = 

ENCB = 

 

Lesson 3: Banner Forms 
Topic 1: Understanding Form Names 

(Return to Table of Contents) 
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Topic 2: Accessing Banner Forms 

Every time you log on to Banner, the “Main Menu” appears.  From here, there are five  
methods by which you can open a specific form. 

What you will learn in this topic: 

• How to navigate to a specific form using the Go To… field on the Main Menu. 

• How to navigate to a specific form using the Direct Access method. 

• How to navigate to a specific form using the Main Menu folder hierarchy. 

• How to use My Banner. 

• How to navigate to a specific form using the Last 10 Forms option. 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

 

(Return to Table of Contents) 
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Discussion: Go To… Field 

You can use the Go To… field to 
open a menu or form by typing its 
seven-character acronym into the 
field and pressing the enter key.   

Go To… 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

 

(Return to Table of Contents) 
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Procedure: Go To… Field 

Using Go To… : 
With Banner open: 
 
1) Enter the seven-character 

name of the desired form in the 
Go to… field. 

2)  Press Enter. 
The requested form is opened. 

 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

Go To… 

(Return to Table of Contents) 
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Discussion: Direct Access 

You can also use the Direct 
Access method from within a form 
to open another form without 
closing the current form. 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

 
1 

2 

(Return to Table of Contents) 
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Procedure: Direct Access 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

Using Direct Access… : 
With a Banner form open: 
 
1) Click FILE on the menu bar 
2) Click DIRECT ACCESS 
3) Enter the form name 
4) Press ENTER. 

 

3 

(Return to Table of Contents) 
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On Your Own Activity: Go To… and Direct Access  

Lesson 3: Banner Forms 
Activity: Using Go To... Field and Direct Access 

1) Using the Go To…  field on the main menu, open PPAIDEN.  After PPAIDEN opens… 

2) From the file menu, use Direct Access to open SPAIDEN.  

(Return to Table of Contents) 
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You can also navigate to a 
specific form using the ‘main 
menu.’ 
You can expand and collapse 
menus by double-clicking the 
folder icons that appear to the 
left of the name.   
If a closed folder icon appears, 
double-click it to expand the 
menu.  The closed folder icon 
changes to an open folder icon 
when the menu contents are 
visible. 
If an open folder icon appears, 
double-click it to collapse the 
menu.   

Discussion: Main Menu Access to Forms 

Expanded menu. 

7 Character 
Form Names 

Sub-menus or forms available 
from the selected menu 

 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

Currently selected menu (blue) 

(Return to Table of Contents) 
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Procedure: Main Menu Access to Forms 

To Expand a Menu: 

1) Double-click the folder icon next 
to SCT Banner. 

2) Double-click the folder icon next 
to Student. 

3) Double-click the folder icon next 
to Course Catalog. 

4) Select the appropriate form you 
wish to open from the Course 
Catalog menu. 

 

3 
2 

1 

4 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

(Return to Table of Contents) 



 Page: 42 

Version 1.2 
June, 2007 

Procedure: My Banner 

To add a form to My Banner : 

1) Right-click your mouse from 
within the form you want to add 
to your personal menu. 

2) Select Add to Personal Menu. 
The next time you log in to Banner, 

the form will appear in the My 
Banner folder when you open it.  

 

2 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

(Return to Table of Contents) 
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The My Banner selection on the 
main menu gives you the option 
of creating a personal menu of 
your most frequently used forms. 
From within a form, simply right-
click your mouse and select Add 
to Personal Menu. 
This simple procedure will place 
a shortcut to the current form in 
the My Banner folder on the 
Main Menu. 

Discussion: My Banner  

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 

(Return to Table of Contents) 
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Discussion: Last 10 Forms Used 

You can quickly re-access a form 
that was previously open in the 
current session.  The bottom of 
the ‘File’ pull-down menu lists 
the last forms (up to 10) you 
have used. 

• Click the File menu. 
• Click the desired form. 

 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 
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Procedure: Last 10 Forms 

Procedure:  
From the main menu: 

1)  Click the File menu. 

2)  Select the PEAEMPL form. 

PEAEMPL opens 

Click Exit to return to the main   
menu. 

 

1 

2 

Lesson 3: Banner Forms 
Topic 2: Accessing Banner Forms 
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On Your Own Activities: Accessing Banner Forms 

The five ways to access forms in Banner are: 

1) 

2) 

3) 

4) 

5) 

 

For this activity, there are two parts: 

A)  Open Banner and access the identification form 
 SPAIDEN using the folder icons from the main 
 menu.  (Hint: Found on the General Person Menu). 

 After you have successfully opened the form, click exit 
 to return to the main screen. 

B)  Open the same form from the main menu, but this time 
 use the Go To… field. 

 After you have successfully opened the form, click exit 
 to return to the main screen. 

Activity 2: Activity 1: 

Lesson 3: Banner Forms 
Lesson Activities – Accessing Banner Forms  
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Review: Banner Forms 

In this lesson you: 
•  Learned about the way Banner form names are constructed, and how to decipher their function. (Topic 1) 

•  Learned some of the ways to move (or navigate) through Banner and access forms using: 

– Go to… :   You can access a menu or form by its seven-character name. (Topic 2) 

– Direct Access:   You can access a form by using the code/description lookup feature. (Topic 2)  

– Main Menu:  You can select from a list of menus and forms in Banner. (Topic 2) 

– My Banner:  You can create shortcuts to frequently used forms by adding them to your personal menu. 
(Topic 2) 

– Last 10 forms in the File pull-down menu:  You can quickly re-access a form that was previously 
opened in the current session. (Topic 2) 

 

 

Lesson 3:  Banner Forms 
Lesson Review 
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Lesson 4: Performing Inquiries - Overview & Agenda 

Lesson Agenda 

 Topic 1: Query basics, wildcards  
 Topic 2:  Perform a query using a form field 
 Topic 3: Perform a query using an application form 
 Topic 4: Perform a query using an inquiry form 
 Topic 5: Common forms to Query 
 

 

Lesson Overview 

Perhaps one of the most powerful features of Banner is the ability to search for information. 

Banner allows you to search for information using query functions. 

Another way Banner allows you to search is by using forms specifically designed for 
performing inquiries. 

Lesson 4: Performing Inquiries 
Lesson Overview & Agenda 
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Topic 1: Query Basics and Wildcards 

Querying is the process of looking to see what information is already entered in the 
Banner database.  You can use inquiry forms, query forms, and most application forms 
to perform queries. 

Some forms automatically open in query mode, usually because a large number of 
records have been retrieved.  When a form opens in query mode, Enter Query 
appears in the status line.  You can immediately specify search criteria to narrow the 
search. 

 

Lesson 4: Performing Inquiries 
Topic 1: Query Basics and Wildcards 
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Discussion: Wildcards In A Search 

You can use the wildcards, “ %” 
and “_”  in defining the search 
criteria.  

The % character represents any 
number of unspecified characters.  

The “_” (underscore) character 
represents a single, unspecified 
character.  

NOTE: With experience, it 
becomes easier to narrow your 
queries to get the results you want. 

Graphic for form not populated 

 

Lesson 4: Performing Inquiries 
Topic 1: Query Basics and Wildcards 

Examples: 
To get these results: Enter this criteria: 

 
Sample result: 
 

All entries that begin with “ma” Ma% Marianne 

All entries that have “ma” as the last 
two characters 

%ma Comma 

All entries that contain “ma” in the 
name  

%ma% Superman 

All entries that begin with “37,” that 
have 3 characters 

37_ 377 

All entries that begin with “s,” but 
have only 5 characters 

S_ _ _ _ Stern 

All entries that have “m” as the 
second character 

_m% Smith 
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Procedure: Performing a Query 

Here are the basic steps to performing a query in Banner. These most closely illustrate the search 
process using either application or inquiry type forms. 

1. Access the form to run the search in. 

2. If the form opens in query mode (Enter Query is in the status line), go directly to step 3.  If the 
form has data in the fields, it is not in query mode. In this situation, click the Enter Query toolbar 
button          or press the F7 key to clear the content of the form. 

3. Enter the search criteria. Remember, the more search criteria you enter, the more specific your 
search results. 

 

Note:  Except when dealing with people, capitalization does not matter. 
 

4. Click the Execute Query toolbar button or press the F8 key.  The form then displays all records 
that match the search criteria. 

 

Lesson 4: Performing Inquiries 
Topic 1: Query Basics and Wildcards 
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Procedure: Perform a Query from a Form Field 

1. In a form field (i.e. ID, Name, 
etc), enter the search 
parameters.  

2. Press the Enter key. 
3. The number of records 

found (search results) is 
displayed. 

4. Click the down arrow next to 
the ‘Search Results’ field to 
display the matching 
records. 

5. Click the desired record to 
return it to the form.  

 

Lesson 4:  Performing Inquiries 
Topic 4: Perform a Query from a Form Field 

1 

3 
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Discussion: Performing a Query from a Field (cont.) 

Other options within the pop-up 
search results window allows 
you to add more criteria if 
needed: 

1. Confine the search to person or 
‘non-person.’  

2. Cancel this search and return to 
the form. 

3. Narrow the search by city, 
state, zip code, birth date, etc. 

4. Re-run the query using 
additional search parameters. 

5. The number of records found in 
the query are displayed. 

 

4 

2 

1 

3 

Lesson 4:  Performing Inquiries 
Topic 4: Perform a Query from a Form Field 

5 
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Steps: Action: 
1)  Open PEAEMPL Loads the employee information form. 

2)  Delete any entry in the ID field, then tab to the next 
field. 

Positions cursor in field to be searched on. 

3)  Type “grov%” (w/o quotes) in the field and press Enter 
to execute the query. 

Displays all entries that begin with the characters “grov.” 

Since the Search Results window contains 90 matches, we will narrow the search again by  
adding an additional search parameter. 

5)   In the zip code field, type 48202 and then Execute 
Query by pressing F8. 

RE-executes the search, but only against the original 
matches for those who live in this area code. The number 
of matches appears. 

6)  Click the down-arrow next to the ‘search results’ field 
and select the record for Barbara A. Grover. 

A single click will select and return the specific employee 
record back to the application form (PEAEMPL). 

7)  “Next Block” using the toolbar or Ctrl + Pg Down on the 
keyboard. 

“Populates” the data block fields with the applicable 
information. 

On Your Own Activity: Perform a Query from a Form Field  

Lesson 4: Performing Inquiries 
Topic 4: Activity - Perform A Query from a Form Field 
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Discussion: Query Using an Application Form  

Lesson 4:  Performing Inquiries 
Topic 3: Perform a Query Using an Application Form 

1. Click the search (down arrow) 
button next to the field to be 
searched on.  

2. The Options List box may 
appear providing links to other 
Banner forms that may assist 
with your query. 

3. On the Banner form, enter in 
the search criteria and 
execute the query (F8). 

4. Double-click in the ID field of 
the selected record to 
populate the original form. 

 

1 

4 

2 

Note: If you find a query results in too many matches, you could use the rollback (shift/F7)      
function to re-enter the search parameters adding an additional criteria.  

For example, adding some portion of a first name to supplement a query based on only last 
name data, would narrow down the results. 
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Discussion: Query Using an Application Form – cont.  
When you select an individual’s 
record and double click on the ID 
field, you are returning back to the 
original form when you can then 
access further information about 
that person. 

Next block to populate the data 
fields.  If additional information is 
needed, you can click on the 
navigation tabs or access other 
forms through the Options menu.   

Lesson 4:  Performing Inquiries 
Topic 3: Perform a Query Using an Application Form 
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Steps: Action: 
1)  Open SPAPERS using the Go to… field. Loads the General Person form. 
2)  Click the search (down arrow) key        next to the ID  

field. The Option List dialog box appears 

3)  From the Option list, select Person Search. Loads the SOAIDEN Person Search form. 
4)  Click in the last name field and enter “des_” (w/o 

quotes) as the search criteria. To find records with 4 letters that start with “des”.  

5)  Click Execute Query           on the toolbar, or press 
F8. Runs the search. 

If you get too many matches here, press F7 to clear the screen and search again. This time, add the first 
name… 

6)  In the last name field, re-enter “des_” and then tab to 
the first name field and enter in “robert” and then 
Execute Query. 

Reruns the search with the added criteria. 

7)  Double-click the I.D. for Robert Isaac Dess. Robert Isaac Dess’ information is returned to the 
SPAPERS form.  

8)  “Next Block” using the toolbar or Ctrl + Pg Down on 
the keyboard. 

Next block  causes the data to populate the record  
fields. 

On Your Own: Perform a Query Using an Application Form   

Lesson 4: Performing Inquiries 
Topic 3: Activity – Perform a Query Using An Application Form (Return to Table of Contents) 
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On Your Own: Perform a Query Using an Application Form  

Steps: Action: 
Open form FTMVEND. The Vendor Maintenance form opens. 
1)  Click the search button           next to the 

Vendor field. 
Loads the FTIIDEN Entity Name/ID Search form. 

2)  Tab to the last name field and enter “East%” 
(w/o quotes) as the search criteria. 

To find all matching records that start with “East”. 

3)  Press F8 or click the Execute Query            
button         on the toolbar 

The query is executed and the search results are 
displayed. 
 

4)  Double-click the ID # for Eastman Fire 
Protection, Inc. 

Eastman Fire Protection information is returned 
to the FMTVEND form. 

5)  “Next Block” using the toolbar or Ctrl + Pg  
Down on the keyboard. 

Next block causes the data to populate the 
record fields. 

6)   From the Options menu, select Vendor 
Addresses.  

The Address tab opens, displaying the address 
for Eastman Fire Protection, Inc. 

Lesson 4:  Performing Inquiries 
Topic 3 Activity: Perform a Query Using an Application Form 
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Discussion: Perform a Query Using an Inquiry Form   

Lesson 4: Performing Inquiries 
Topic 2: Perform a Query Using An Inquiry Form 

You can also use an inquiry 
form to search for 
information. 

1. Launch the inquiry form 
you will be using and 
enter the criteria into a 
field within the form. 

2. Execute the query and 
the results will be 
displayed on the form. 

1 

2 
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On Your Own Activity: Perform a Query Using an Inquiry Form 

Steps: Action: 
1) Open SOISBGI Loads source background institution form. 
2) Tab to the Name field and type J%. To display all institutions that begin with the 

uppercase letter J. 

3) Click the Execute Query icon            or press 
the F8 key. 

Executes the query. 
 

4) Ctrl+q to exit the SOISBGI form. Returns to the main Banner screen. 

 

NOTE: Be sure to enter search criteria with proper capitalization! 

Lesson 4: Performing Inquiries 
Topic 2: Perform a Query Using An Inquiry Form 
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Topic 5: Common Forms to Query in HMRS  

7-Character Form Name Form Name Description 
PPAIDEN Identification  Name(s) 

 Address information 
 Basic biographic information 
 Emergency contact information 
 Drivers license numbers  

PPAGENL General Information • Inquire about the educational background of an employee. 

NBAPOSN Position Definition • Inquire on a position’s salary range and/or identify where a position reports. 

NBAPBUD Position Budget • Inquire on  position budgets, premium earnings totals, fringe benefits, and position 
labor distributions. 

PEAEMPL Employee • Inquire on general data, including current status, employee class, leave and benefit 
categories, home and distribution organizations, and service dates. 

NBAJOBS Employee Jobs • Inquire about an employee’s job description, start and end dates, status, hours, and 
salary information. 

PPAINTL International Information • Inquire on an employee’s I9 information. 

PHICHEK Check Detail Inquiry • Inquire on the details of a specified pay event, including check/Direct Deposit 
numbers, recipient, gross and net amounts, earnings codes and rates, deductions, 
and hours worked during the pay period. 

PEAFACT Faculty Action Tracking Inquire on the following eligibility/status for a specific faculty member: 
• Eligibility for a sabbatical 
• Tenure status 
• Reappointments or  leave 

Lesson 4: Performing Inquiries 
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Common Forms to Query in Student  

7-Character Form Name Form Name Description 

SOAIDEN Person Search This form may be used to determine the correct ID number for a person using the 
query capabilities of the system. The name, ID number, birth date, and name type are 
displayed. 

TSAAREV Account Detail The Account Detail Review Form is used to enter and review charge and payment 
information about an account. This form presents an online view of each transaction.  

SIAIQRY Faculty/Advisor Query The purpose of the Faculty/Advisor Query Form is to enable you to select key pieces 
of information about faculty members or advisors and to list those people who meet 
the selection criteria.  

SAAADMS Admissions Application This form is used to identify whether a student has multiple admissions applications.  

SOAHSCH High School Information This form is used to view information related to a high school student’s academic 
history.  

SOISBGI Source/Background Institution This form displays information about an institution’s type, code, and location. 

SHATERM Term Sequence Course History  This form displays the student's current status and GPA information. Scrolling 
institutional, transfer, and overall GPA totals are displayed on this form each time the 
term changes.  

SHADEGR Degree and other Formal 
Awards 

This form is used to review all information pertaining to degrees or other types of 
awards that the student is seeking, or has been awarded.  

SOAHOLD Holds  This form is used to display holds a person may have.  

Lesson 4: Performing Inquiries 
Topic 5: Common Forms to Query 
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Common Forms to Query in FMS  
7-Character Name Form Name Description 

FPIREQN Requisition Inquiry • Inquire on the details of a completed requisition. 

FGIENCD 
(replaces screen 021) 

Detail Encumbrance Activity • Inquire on a specific encumbrance number posted to the system. 
• Provides data on all transactions posted against the specific encumbrance. 

FGITRND 
(replaces screen  
023 & 27) 

Detail Transaction Activity • Inquire on detail transactions for specific FOAPAL elements. 
• Inquire by specific fiscal year. 
• Inquire on specific document information. 

FGIJVCD List of Suspended Journal Vouchers • Inquire on those JVs that are approved, but are pending in the posting process. 

FTMFUND Fund Code Maintenance • Inquire on fund effective date; Inquire on fund/grant relationship;  Inquire on fund roll-ups. 

FTMACCT Account Code Maintenance • Inquire on FMS account codes. 

FWMACCT WSU Account Code Crosswalk Maintenance • Inquire on the new FMS account codes by entering the old FRS object codes. 

FGIOENC 
(replaces screen 021) 

Organization Encumbrance List  • Inquire on the open encumbrances for a specific index, organization, and/or fund. 

FGITBSR 
(replaces screen 018) 

Trail Balance Summary • Inquire on general ledger trial balance activity at the summary level. 
• Inquire by fund and/or account code and fiscal year. 
• Inquire on fund balance. 

FGIBDST 
Replaces screen 019) 

Organization Budget Status Form • Inquire on budget availability by Org., Fund, Program, Account Code, Account type. 
• Inquire on adjusted budget, YTD actual expenses incurred, commitments, and available balance.  
• Inquire on detail transactions for actual YTED activity or by encumbrances. 
• Inquire by specific fiscal year. 

FGIBDSR Executive Summary Form • Inquire on budget availabiitly by specific FOAPAL elements at the highest summary level. 
• Inquire by index and fiscal year;   Inquire by detail description. 

FOIDOCH Document History • Inquire on all aspects of a purchase requisition. 

Lesson 4: Performing Inquiries 
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Review: Performing Inquiries 

In this lesson you: 

• Defined what a query/inquiry is (Topic 1) 

• Defined available search ‘wildcard’ options (Topic 1) 

• Performed a query from a form field (Topic 2) 

• Performed a query using an application form (Topic 3) 

• Performed a query using an inquiry form (Topic 4) 

• Reviewed a list of commonly used query forms (Topic 5) 

 

Lesson 4:  Performing Inquiries 
Lesson Review 
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 

What you will learn in this lesson: 

Topic 1.   Define and identify FOAPAL string and elements 
Topic 2.  Identify Index codes 

The FOAPAL string of codes is the core of the Banner Financial Management System (FMS). FOAPAL 
is the hierarchy coding system FMS uses for classification, budgeting, and recording. It also gives users 
the ability of reporting and making inquiries at multiple levels. 
 
Virtually every task in FMS will require the use of the FOAPAL string of codes in some form or another. 
Understanding the concept of FOAPAL is essential for you to work successfully in FMS. 
 
In the next few pages you will learn what role it plays in your dealings with FMS: 

Lesson 5 :  Understanding FOAPAL 
Overview 

Lesson 5: Understanding FOAPAL - Overview 
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Discussion: Definition of FOAPAL 

Definition of FOAPAL: 
 

The FOAPAL "string" is used to convey important accounting information 
specific to a financial transaction or labor costs. This assembly of various 
accounting codes is established and maintained by WSU Fiscal Operations.  
 

Virtually every task and every form within FMS will require the use of the full FOAPAL 
string of codes. The use of the FOAPAL string also gives you the ability to report and 
make inquiries at multiple levels. 

 

Here is an example of a FOAPAL string of codes as used in FMS: 

Lesson 5: Understanding FOAPAL 
Topic 2: Define and Identify FOAPAL String and Elements 
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Discussion: FOAPAL string of codes—What does it stand for?  

F O A P A L COA 

Lesson 5: Understanding FOAPAL 
Topic 2: Define and Identify FOAPAL String and Elements 

Important WSU Codes: 
• Chart of Accounts (COA) is a systematic classification of accounts. WSU uses only one COA: W. 
• Index is a six character code that serves as a shortcut to many of the FOAPAL string combinations. 
• Fund identifies the source from which the money is being drawn.  
• Organization (Orgn) identifies the budget unit of the school, college, division, or department that is 

processing the transaction. Examples: Dean of Libraries, Center for Urban Studies, College of Engineering. 
• Account Code (Acct) identifies what financial activity is being recorded. Examples: assets, liabilities, fund 

balance, revenues, expenditures, transfer.  
• Program (Prog) identifies the purpose of the transaction. Examples: instruction, academic support, research 
• Actv = Activity is not currently used at WSU. 
• Locn = Location is used only for plant funds. 

Note: To create a 
FOAPAL, you need 
two pieces of 
information, the 
index code and 
account code.  

(Return to Table of Contents) 
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Discussion: Identify Index Codes 
The Index Code is a six-character code that serves as a shortcut to completing a  
FOAPAL string. 
 
As you can see from the example below, entering the153381 code into the index field 
will populate all FOAPAL element fields except for the Account Code. 
 
When using Index Codes, you must always provide the FMS Account Code yourself. 

 

Lesson 5: Understanding FOAPAL 
Topic 3: Identify Index Codes 

F O A P A L Index 
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Review: Understanding FOAPAL 

In this Lesson you learned: 

• The definition of FOAPAL and identifying FOAPAL string 
• How to identify index codes 

 

Lesson 5: Understanding FOAPAL 
Lesson Review 
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Lesson 6: Features In Banner - Agenda 

Lesson Overview 

Banner is equipped with many convenient features such as calendar and calculator functions.  

As you become more proficient working with Banner, you’ll find these features and others very 
useful. 

Lesson Agenda 

Topic 1:   Use the Calculator and Calendar 

Topic 2:  Change your Banner password 

 

 

Lesson 6: Features in Banner 
Lesson Overview - Agenda 

 
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Topic 1: Use the Calculator and Calendar 

Banner’s Calculator and Calendar functions are conveniently connected to related 
fields within every Banner form.  A double-click within a field for either a date or numeric 
type data will activate the associated calculator or calendar tool. 

• If the form’s numeric field has a value, the calculator starts with that value. You 
can then use the mouse, number keys on the keyboard, or the numeric keypad (if 
the Num Lock is enabled) to make calculations.  

• If the date field has a value, the calendar starts with that date highlighted. If the 
date field is empty, the calendar highlights the current date.  

Lesson 6: Features in Banner 
Topic 1: Use the Calculator & Calendar 

 
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Discussion: Use The Calculator 

If you access the calculator by double-clicking in a 
numeric form field, clicking the OK button will return 
the calculated value to the ‘calling form.’  

You can also access the calculator via the Go to… field 
by entering GUACALC.  When accessed this way, the 
calculator works independently of any form or field and 
you cannot return a calculated value to a form. 

Lesson 6: Features in Banner 
Topic 1: Use the Calculator & Calendar 

 
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Discussion: Use the Calendar 

Accessing the calendar via the calendar icon 
next to a date field allows you to click the 
desired date to return that value to the ‘calling 
form.’  

You can also access the calendar with the Go 
to… field by entering GUACALN.  When 
accessed this way, the calendar works 
independently of any form or field. This means 
you cannot select a date and return it to a 
form. 

Lesson 6: Features in Banner 
Topic 1: Use the Calculator & Calendar 

 
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Procedure: Use the Calendar 

Procedure: 
In a Banner form:  
 
1. Place the cursor in a From field. 
2. Click the calendar icon next to 

the From field. 
3. Select a date. 
4. Click OK to populate the date 

field on the form with the 
selected date. 

Here we’ve used the SOAHOLD 
form to illustrate these steps. 

 

Lesson 6: Features in Banner 
Topic 1: Use the Calculator & Calendar 
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On Your Own Activity: Use the Calendar 

Steps: Action: 
1) Open SPAIDEN. The form opens. 
2) Block Next / Ctrl + Pg Down. Moves cursor to next block, and populates data 

fields. 
3) Click the Addresses link on the Options Menu. Opens the addresses screen. 
4) Click the calendar icon next to the “From” field. The calendar appears. 
5) Select a date of your choice. The date is highlighted. 

Note: Clicking the desired date automatically 
returns that date to the form field. 

6) Click the OK button The date selected returns to the From date field. 

 

Lesson 6: Features in Banner 
Topic 1: Use the Calculator & Calendar 
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Topic 2: Change Banner Password  

There are a number of reasons why you might want to change your Banner password, so 
here’s the procedure to use. 

NOTE: You can make your Banner (Oracle) password the same as the password you use 
for WSU e-mail, as long as it does not start with a number. 

 

Lesson 6: Features in Banner 
Topic 3: Change Banner Password 
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Procedure: Change Banner Password 

Procedure: 
 

1) Click Change Banner Password 
under My Links on the Main Menu. 

2) The Oracle Password Change Form 
appears. Here, type your current 
password in the  “Oracle password” 
field. 

3) Type a *NEW password in the “New 
Oracle Password” field*. 

4) Tab to “verify password” field and re- 
type your new password. 

5) Click Save       or press the enter/return 
key. 

 

*NOTE: Do NOT start your new password 
with a number or special character! If 
you do, the system will not respond and 
will not even display an error message.  

Lesson 6:  Features in Banner 
Topic 3: Change Banner Password 
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Review: Features in Banner 

In this lesson you learned how to do the following: 

• Use the calculator function of Banner (Topic 1) 

• Use the calendar function of Banner (Topic 1) 

• Change your Banner user password (Topic 2) 

 

Lesson 6:  Features in Banner 
Lesson Review 
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Appendix – Session Key Points 

We have compiled some of the key information from this session for 
quick reference:  

• Toolbar buttons reference chart 

• Keyboard Shortcuts chart 

• Form name basics 

• Most commonly used inquiry forms 

Appendix: Quick Reference 
Overview 
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Topic 1: Parts of the Interface 

Appendix: Quick Reference 
Topic 1:  Parts of the Interface 

Tool Tips provide the name 
of the button the mouse 

cursor is pointing at. 

View/Send 
Message 

Next 
Block Save Select 

Remove 
Record 

Previous 
Record 

Previous 
Block 

Rollback Insert 
Record 

Enter 
Query 

Cancel 
Query 

Next 
Record Exit 

Print  
 

Help 

SCT Banner 
XtenderSolutions 

Execute 
Query 
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Topic 2:  Keyboard Shortcuts 

NOTE: Data entry users will make good 
use of these “permission-based” 
shortcuts: 

•  F4  Duplicate record 
•  F6  Insert record 
•  Shift/F6  Delete record 
•  F10  Save record 

Here’s a collection of some of the most 
useful keyboard shortcuts. 

Appendix: Quick Reference 
Topic 2:  Keyboard Shortcuts 

Keys Description 

Ctrl F1 Display “Show Keys” window 

F2 | shift + F2    --  | count query hits 

F3 | shift + F3    -- | SELECT record 

F4 | shift + F4 Record duplicate | 

F5 | shift + F5    --  | Clear block 

F6 | shift + F6 Insert record  | Delete record 

*F7 | shift + F7 Enter query | Rollback 

*F8 | shift + F8 Execute query   | print 

F9 List – Search 

F10 Save changes 

*Ctrl + pg  Next block 

*Ctrl + pg  Previous block 

Ctrl + u Clear item field 

*Tab Next item field 

Shift Tab  Previous item field (reverse direction) 

Ctrl + q Acts as ‘exit’ button – cancels a query or exits 
current form 
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Topic 3: Understanding Form Names 

Position 1: 
Identifies the primary system 
owning the form 

 
Position 2: 

Identifies the business process 
(module) owning the form 

 
Position 3: 

Identifies the form type 
 
Position 4-7: 

Uniquely identifies the form 

1 
• Accounting (T) 
• HR/Payroll / 
Personnel (P) 

• Position Control 
(N) 

• Student (S) 
• Financial (F) 

2 
• General Person (P) 
• Application (A) 
• Budget (B) 
• COBRA (C) 
• Benefit/Deductions (D) 
• Employee (E) 
• Electronic 
               Approvals (R) 
• “Overall” to a business 

process (O) 
• General to a business 

process (G) 
• Purchasing (P) 

3 

• Application (A) 
• Inquiry (I) 
• Validation (V) 
• Maintenance (M) 

4-7 
• Identification (IDEN) 
• Position (POSN) 
• Encumbrance (ENCB) 
• Employee (EMPL) 
• Job information 
 (JOBS) 
• Requisition (REQN) 
• Check (CHEK). 

P P A IDEN 
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Topic 3:  Understanding Form Names 
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Topic 4: Common Forms to Query in HRMS 
7-Character Form Name Form Name Description 

PPAIDEN Identification  Name(s) 
 Address information 
 Basic biographic information 
 Emergency contact information 
 Drivers license numbers  

PPAGENL General Information • Inquire about the educational background of an employee 

NBAPOSN Position Definition • Inquire on a position’s salary range and/or identify where a position reports 

NBAPBUD Position Budget • Inquire on  position budgets, premium earnings totals, fringe benefits, and position 
labor distributions. 

PEAEMPL Employee • Inquire on general data, including current status, employee class, leave and benefit 
categories, home and distribution organizations, and service dates. 

NBAJOBS Employee Jobs • Inquire about an employee’s job description, start and end dates, status, hours, and 
salary information. 

PPAINTL International Information • Inquire on an employee’s I9 information 

PEAFACT Faculty Action Tracking Inquire on the following eligibility/status for a specific faculty member: 
• Eligibility for a sabbatical 
• Tenure status 
• Reappointments or  leave 

Appendix:  Quick Reference 
Topic 4:  Common Inquiry Forms 
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Topic 4:  Common Forms to Query in Student 

7-Character Form Name Form Name Description 

SOAIDEN Person Search This form may be used to determine the correct ID number for a person using the 
query capabilities of the system. The name, ID number, birth date, and name type are 
displayed. 

TSAAREV Account Detail The Account Detail Review Form is used to enter and review charge and payment 
information about an account. This form presents an online view of each transaction.  

SIAIQRY Faculty/Advisor Query The purpose of the Faculty/Advisor Query Form is to enable you to select key pieces 
of information about faculty members or advisors and to list those people who meet 
the selection criteria.  

SAAADMS Admissions Application This form is used to identify whether a student has multiple admissions applications.  

SOAHSCH High School Information This form is used to view information related to a high school student’s academic 
history.  

SOISBGI Source/Background Institution This form displays information about an institution’s type, code, and location. 

SHATERM Term Sequence Course History  This form displays the student's current status and GPA information. Scrolling 
institutional, transfer, and overall GPA totals are displayed on this form each time the 
term changes.  

SHADEGR Degree and other Formal 
Awards 

This form is used to review all information pertaining to degrees or other types of 
awards that the student is seeking, or has been awarded.  

SOAHOLD Holds  This form is used to display holds a person may have.  

Appendix: Quick Reference 
Topic 4:  Common Inquiry Forms 
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Topic 4:  Common Forms to Query in FMS 
7-Character Name Form Name Description 

FPIREQN Requisition Inquiry • Inquire on the details of a completed requisition 

FGIENCD 
(replaces screen 021) 

Detail Encumbrance Activity • Inquire on a specific encumbrance number posted to the system 
• Provides data on all transactions posted against the specific encumbrance 

FGITRND 
(replaces screen  
023 & 27) 

Detail Transaction Activity • Inquire on detail transactions for specific FOAPAL elements 
• Inquire by specific fiscal year 
• Inquire on specific document information 

FGIJVCD List of Suspended Journal Vouchers • Inquire on those JVs that are approved, but are pending in the posting process 

FTMFUND Fund Code Maintenance • Inquire on fund effective date; Inquire on fund/grant relationship;  Inquire on fund roll-ups 

FTMACCT Account Code Maintenance • Inquire on FMS account codes 

FWMACCT WSU Account Code Crosswalk Maintenance • Inquire on the new FMS account codes by entering the old FRS object codes 

FGIOENC 
(replaces screen 021) 

Organization Encumbrance List  • Inquire on the open encumbrances for a specific index, organization, and/or fund 

FGITBSR 
(replaces screen 018) 

Trail Balance Summary • Inquire on general ledger trial balance activity at the summary level 
• Inquire by fund and/or account code and fiscal year 
• Inquire on fund balance 

FGIBDST 
Replaces screen 019) 

Organization Budget Status Form • Inquire on budget availability by Org., Fund, Program, Account Code, Account type. 
• Inquire on adjusted budget, YTD actual expenses incurred, commitments, and available balance.  
• Inquire on detail transactions for actual YTED activity or by encumbrances. 
• Inquire by specific fiscal year. 

FGIBDSR Executive Summary Form • Inquire on budget availabiitly by specific FOAPAL elements at the highest summary level. 
• Inquire by index and fiscal year;   Inquire by detail description 

FOIDOCH Document History • Inquire on all aspects of a purchase requisition. 

Appendix: Quick Reference 
Topic 4:  Common Inquiry Forms 
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Congratulations! 

You should now be able to perform the following: 
– Navigate in Banner 
– Execute basic Banner inquiries 

 
With these skills you will be able to use Banner efficiently and effectively.  While these 
skills are fresh in your memory, be sure to apply them as soon as possible when back at 
your computer. 
 
We have created a training version of Banner which will allow you to use these skills 
right away.  This training version is Banner V7.x Sandbox as found at: 

http://bantest.wayne.edu 
Feel free to perform whatever functions you wish in this training version.  You cannot 
harm any data while working in the “sandbox,” so jump in! 

Thank you for all your effort and time! 
 

Reminder! 
Sandbox username = train01 or train99 
Sandbox password = Change 
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